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Disclaimer

Any opinions and findings in this publication do not necessarily reflect the views of the National
Science Foundation (NSF), Pacific Earthquake Engineering Research Center (PEER), California
Department of Transportation (Caltrans), Program of Earthquake Applied Research for Lifelines
(PEARL), Pacific Gas & Electric Company (PG&E), California Energy Commission (CEC), and
Los Angeles Department of Water and Power (LADWP). Additionally, none of the institutions
cited above, nor any of their respective employees make any warranty, expressed or implied, nor
assume any legal liability or responsibility for the accuracy, completeness, or usefulness of any
information included in this publication.

The liquefaction-induced ground deformation database is intended for use by PEER,
'CALTRANS, PG&E, PEARL and LADWP researchers. This CD-ROM may not be copied
without permission, nor may the data or files contained within be distributed to any third party.

The database containing the case histories of liquefaction ground deformation from Kobe, Japan,
was developed in association with Kobe University, Japan, and originates mostly from the
KOBE JIBANKUN database, which is protected under the copyright of “Research group of
Kobe’s ground.” Under the copyright terms of KOBE JIBANKUN, users:

e are responsible for the use and storage of the data.
e cannot duplicate the database without permission.
e bear full responsibility for the results obtained using “KOBE JIBANKUN.”

e must explicitly write the following references when publishing results obtained from “KOBE
JIBANKUN.” Kobe City, Kensetsu-Kougaku Kenkyu-syo, Database of Kobe’s ground
“KOBE JIBANKUN,” Research group of Kobe’s ground, 1999.

Permissions to use data from KOBE JIBANKUN can be obtained by sending written requests to:

Kobe no Jiban Kenkyu-kai Jimu-kyoku

“Research Group of Kobe’s ground”

Zaidan Ho-jin Kensetsu Kougaku Kenkyu-syo

1-3-10 Tsurukabuto Nada-ku Kobe-shi, 657-0011, Japan
Tel: +81-78-851-1850, Fax: +81-78-851-5454
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SUMMARY

The liquefaction ground deformation database contains information on case histories of ground
deformations induced by liquefaction after worldwide earthquakes. The database is intended for
usage by researchers and practitioners in geotechnical earthquake engineering. Its development
was prompted to improve the probabilistic models of liquefaction-induced ground displacement
used for estimating damage to lifelines after earthquakes.

The database summarizes the state-of-the-art knowledge on case histories of liquefaction-
induced ground deformation originating from the 1964 Niigata, Japan, earthquake; 1971 San
Fernando, California, earthquake; 1983 Nihonkai-chubu (Noshiro), Japan, earthquake; 1994
Northridge, California, earthquake; and 1995 Hyogoken Nanbu (Kobe), Japan, earthquake. The
database was constructed by identifying, collecting, organizing and digitizing available data sets
on liquefaction-induced ground displacements. The data originating from different sources have
been combined and archived. Legacy data, including hardcopy data reports on displacement
vectors and soil SPT and CPT boreholes, have been converted to digital data format and stored in
ASCII and GIS formats. All data have been structured and screened using a relational database
management system (RDBMS), and were published into organized files systems readily usable
by researchers in geotechnical engineering, and requiring no RDBMS knowledge. Data file
formats include Microsoft Excel, jpeg and gif for photos and scanned documents, ASCII digital
elevation models (DEM), and GIS shape files.
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1. STRUCTURE AND USAGE OF LIQUEFACTION GROUND DEFORMATION
DATABASE

This section describes the structure of the liquefaction ground deformation database, and
illustrates its usage through a few examples. The database is distributed on two CDs referred to

as CD-1 and CD-2.

1.1 Basic requirements

Table 1 lists the various file formats which are used in the liquefaction ground deformation
database and the programs which are required to read these files. Internet Explorer 5.0 (or
higher) is required to read HTML documents; it can be downloaded from www.microsoft.com.
Microsoft Excel 2000 or higher is required to read Excel workbooks. The liquefaction ground
deformation database CDs includes an Excel97/2000 viewer, which is freely distributed by
Microsoft (www.microsoft.com). The liquefaction ground deformation database contains
boreholes data files, which can be optionally edited and printed using LogPlot2001
(www.rockware.com), and Digital Elevation Models (DEM), which can be optionally edited
using Surfer (www.goldensoftware.com). The liquefaction ground deformation database contains
Geographic Information System (GIS) files. ArcExplorer2.0 and/or ArcGIS8.x are required to
read these GIS files. The liquefaction ground deformation CDs includes ArcExplorer2.0, which
is a GIS viewer freely distributed by ESRI (http://www.esri.com/software/index.html).
ArcExplorer2.0 should be installed on the user’s computers before attempting to read
ArcExplorer2.0 project files. The project files of ArcExplorer2.0, which have aep as file name
extension, are supported only by ArcExplorer2.0, and not by ArcExplorer3.0 and
ArcExplorerd.0. ArcGIS8.x is a GIS program commercially available from ESRI, which has
more advanced GIS features than ArcExplorer2.0, e.g. spatial and geostatistics analysis. The GIS
files, which have for extensions shp, sbn, sbx, shx, and dbf, are called by the project files of
ArcExplorer2.0 (aep) and ArcGISS8.x (mxd)..

Table 1. File formats and required software in liquefaction ground deformation database.
File Type File Extension Associated software
HTML Document .htm Microsoft Internet Explorer 5.0
Microsoft Excel Workbook Xxls Microsoft Excel 2000
JPEG Image File ,ipg Graphic software (e.g., PaintShop)
GIF image File .gif Graphic software (e.g., PaintShop)
ASCII Text File Axt, .dat, .cpd ASCII file editor
Adobe Acrobat Document .pdf Adobe Acrobat Reader
ESRI Shapefile .shp, .sbn, .sbx, .shx, .dbf ArcView3.x / ArcGIS8.x / ArcExplorer2.0
ESRI Coordinate Projection File P : ArcView3.x / ArcGIS8.x
USGS DEM File .DEM ArcView3.x / ArcGIS8.x / Surfer
ArcExplorer2.0 Project File AEP ArcExplorer2.0
ArcGIS8.x Project File .MXD ArcGIS8.x
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1.2 Organization of data

As shown in Fig. 1, the liquefaction ground deformation database is distributed on CDsas linked
file systems. Files can be moved from the CDs to other media only as entire directory for
preserving links between files. The main access point is the HTML file called contents.htm. The
folder HTML Files contains accessory materials common to the case histories (e.g., logos). The
folder FileViewers includes the installation files for ArcExplorer2.0 and Excel Viewer, in case
these programs are needed.

grmem e e me e

## PEERCD :

Name =
£"1Case History 1
£ Case History 2
£*1Case History 3
™ Case History 4
TFileViewers
CHHTML Files
conkents

Figure 1. Directory structure of liquefaction ground deformation database.

As shown in Fig. 1, the case histories of liquefaction ground deformation are organized in
different folders, which are named according to their geographic location. The case histories
included in the CD-1 are listed Figure 2. There are four case histories, named as Loma Prieta,
Niigata, Noshiro and Van Norman Complex, respectively.

@ Liguefa.
Ble £t we ™ &

CfFileViewers |
ZHTML Files

C7Loma Prieta
Z3Nigata

i Noghiro

{=3¥an Norman Complex
‘ @contents

Figure 2. Four case histories included in the liquefaction ground deformation database CD-
1.
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As shown in Fig. 3, all the case histories are organized in four sub-directories (1) Aerial Photos,
(2) Boreholes, (3) Displacements, and (4) GIS Files. These folders include original as well as

processed information.

Filr  Edit View Favorites Tools H ‘
Folders X | heme « L Se Twe
ST x| 25 herial Photos i roider
T £7Boreholes File Folder
= 4 Boreholes =Displacements File Folder
£ Original Data LGS Files File Folder
& £y Processed Data @Dataﬁmnmary 14KB  Microsoft Excel’
£ LogPlot &]Instructions SKB HTML Document
5 £ Displacements
73 Original Data
2 7 GIS Files
™ Base Maps
™ Boreholes
£ DEM
) Displacements ;
% % Case History 2
=% Case History 3
& ¥y FieViewers
£ HTML Files v £
i
Figure 3. Subdirectory structure of case history data in liquefaction ground deformation
database.

The GIS files, which. include ArcExplorer2.0 and ArcGIS8.x project files, require
ArcExplorer2.0 and/or ArcGIS8.x. ArcExplorer2.0 offers basic GIS functions to display and
query spatial data. ArcGIS8.x offers more advanced GIS features.

The database contains some limited amount of metadata. For instance, file DataSummary.xls
contains data on boreholes and displacements data files. There are also Excel files in the
directories Aerial Photos and GIS Files, which summarize file size and type.

1.3 Displaying database contents

As shown in Fig. 4, Contents.htm is the main HTML page which displays the information in the
liquefaction-induced ground deformation database. Contents.htm lists the case histories
contained in this CD. Each case history data can be accessed by clicking on a case history name.

Page 6



alnstruchons M:cmso(t ln!ernet &(p(nrer G
© Fle Edr Vew Fayvortes Indls Help

Ground Deformation Database

Jean-Pierre Bardet
JianPing Hu
Jennifer Swift

Tetsug Tobi

University of Southern California, Los Angelss e

Awailable case histories of ground deformation after earthguakes {click on case history to
access data)
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Figure 4. Case histories of liquefaction-induced ground deformation in CD 1.

As shown in Fig. 5, the complete information about a particular case history is organized using
the same file structure with four subdirectories. The content of each subdlrectorles can be

detailed as follows:

Directory Aerial Photos contains the aerial photos of the areas where liquefaction ground
deformations were measured. This information is useful to get a better understanding of the
areas under study. Most of these aerial photos were taken after the earthquake, and have been
used in the processing of displacement vectors. Aerial photos are either in JPEG or GIF
formats. All the information on aerial photos is summarized in the Excel workbook
AerialPhotos.xls. Photos can be viewed by clicking on their name.

Directory Boreholes contains borehole data. It includes the original scanned borehole profiles
as well as processed borehole data.

o Subdirectory Original Data contains the scanned data, which were used to generate
digital data for boreholes. This information is useful for verifying the transformation
from hardcopy graphics (original reports) to digital data.

o Subdirectory Processed Data contains borehole graphics, ASCII files of borehole
profiles and LogPlot input data files. Using the LogPlot input data files, one can
reproduce and edit independently the boreholes graphics provided in the liquefaction
induced ground deformation database.

Directory Displacements contains data files on liquefaction-induced ground deformation.
Workbook DataSummary.xls summarizes all the information available on boreholes and
displacements. It also contains information on earthquakes. Additional explanations on
Displacements are presented in a later section.
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o Directory GIS files contains the information related to GIS files. Workbook GISFiles.xls
summarizes the GIS files. The GIS files are compatible with ESRI ArcExplorer2.0 and
ArcGIS8.x. It is recommended to use the GIS project files, which have for extension aep for
ArcExplorer2.0 and mxd for ArcGIS8.x, as those contained the various GIS layers. There are
four types of GIS layers: (1) Base map, (2) DEM, (3) Boreholes and (3) Displacements. Base
map is used for geo-referencing spatial data. DEM is used to create digital elevation models.
Boreholes list the shape files used to represent spatial distribution of boring logs.
Displacements give the spatial distribution of displacement vectors.

o Subdirectory Base Maps contains the base maps that are GIS enabled.

o Subdirectory DEM contains the DEM files used to generate elevation models and
topography.

% Data Structure - Microsoft Internet Explorer
. Fle Edit View Favorites Took Hebp

M serial Photos

Folders

& 0 GIS Fles
23 Basemaps
i Boreholes
£ DEM )

Figure 1. Data structure for case history of ground deformation
Information on case history is stored in 4 subdirectories:

» Aerial photos Scanned aerial photos after earthquake

+ Boreholes: Geotechnical information on soil deposits

« Displacements: Measured displacement vectors

o GIS files Files for GIS analysis o

Figure 5. Sub-structure of case history data as displayed in the liquefaction ground
deformation database.

1.4 Data presentation using Excel Workbook

Displacement vectors and borehole information are tabulated and keyed using geographic
coordinates. The database reports displacement vectors and borehole data in the Workbook
DataSummary.xis for those who are mostly familiar with spreadsheets. Workbook
DataSummary.xls provides users with some basic graphical display capabilities, which can be
used to explore and query the database. Workbook DataSummary.xls contains seven worksheets:

1. Definitions: Terms used to.characterize borehole data
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GISMap: Graphic display of boreholes and displacement vectors

Summary: Summary results on boreholes and displacement vectors

Boreholes: Coordinates, types, files, and references for boreholes

Displacements: Coordinates and amplitude of deformation

Earthquake: Earthquake information

References: List of references about boreholes

Worksheets GISMap, Boreholes and Displacements can be used to query and visualize data
graphically. Table 2 defines the headers of worksheets Borehole, Displacement, Earthquakes and

References.
Table 2. Headers in worksheets Boreholes, Displacements, Earthquakes and References.
Worksheet Header Description
Boreholes ID Borehole 1D
Name Borehole name
Type Borehole type (SPT, CPT, etc)
TestDate Test date
Northing Northing coordinate of borehole location (m)
Easting Easting coordinate of borehole location (m)
Elevation Elevation (m)
GWT Ground water depth (9999 means no measurement)
ProcessedData Text file containing digital version of borehole information
OriginalScanedimage Original scanned borehole profile used for creating Processed Data
LogPlotData Data file for LogPlot
Graph Graphic file of borehole profile generated using Processed Data
Reference Reference number on borehole
Displacements No Vector ID
Xbefore x-coordinate before earthquake (m)
Ybefore y-coordinate before earthquake (m)
Zbefore z-coordinate before earthquake (m)
Xafter x-coordinate after earthquake (m)
Yafter y-coordinate after earthquake (m)
Zafter z-coordinate after earthquake (m)
Hdisp Lateral displacement (cm)
Vdisp Vertical displacement (cm)
Earthquakes EqID Earthquake ID
EqNm Earthquake name
Date Date earthquake happened
Latitude Latitude of epicenter
Longitude Longitude of epicenter
Magnitude Magnitude of earthquake
MagType Magnitude type
References  ReflD Reference 1D
Authors Authors
Date Publication date
Title Title of reference (including source)
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Figure 6 displays the GISMap worksheet for the case history on the 1964 Niigata, Japan
earthquake. The base map represents Niigata city boundary. The arrows represent the
displacement vectors, which correspond to the displacements of actual objects tracked on aerial
photographs before and after the earthquake. As shown in Fig. 6, the dots represent the borehole
locations. The Display button is used to display interactively the result of user-defined queries.
The Clear All button erases all of the dots and vectors.

E.‘Micrns_nﬁmifﬁ.:el‘-_Data'Summary " |

e R vew fwn fymx  [nos P T——— %
Display J_ Clear Al | 49300 52300 55300 E
215050l =+ -+ + ~+ 18050 H
Map scale: 1 km bt
I
Vactor scale:
216059 i - P16050
214050 214050
212059 nR 12050
Hooso e NP S TR AN e TR e ST N T 10050
208050 + + + + R0BOSO
35300 ~35300 52300 25300
i 4y W Defiitions \GISMap { Summary { orebies [ Disclacements [ Earthouake. [ References ol I |
Figure 6. Graphics in Excel worksheet GISMap displaying location of boreholes and

displacement vectors in Niigata, Japan.

Microsoft Excel provides users with some basic capabilities to query and extract data with
desirable properties, e.g., displacements vectors over a selected region. These techniques are
referred to as filtering. In the Data menu, the function Filter can be used to filter data that meet
the user-defined criteria. The filtered data can be displayed in worksheet GISMap using the
Display button. As shown in Fig. 7, data can be filtered using either Autofilter for basic criteria
or Advanced Filter for more complex criteria. In most cases, Autofilter is versatile enough and
meets most user requirements. Advanced Filter accepts a larger number of query parameters but
is slightly more complicated to use, Advanced Filter performs sophisticated filtering reminiscent
of those offered by SQL (Structured Query Language) in RDBMS. It is recommended to consult
the Microsoft Excel Help before using Advanced Filter.
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.. Type TestDate No
SPT _ BAA1 212 -
SPT 7m0 212
SPT . 772665 212
SPT 702385
SPT  7/18/85 212

SPT 772985 212

F10_7 ” : - >
8 F108 A5 212
3F108 . 9/23/64 212
10-F10-10 SPT = 9/729/84
11 F10-11 10/1/64
10/mB4 212
1034
14 78074
15 F10-15 /7!

Figure 7. Data query using AutoFilter in Excel spreadsheet.

Two examples of user queries are given below to illustrate the application of AutoFilter to the
liquefaction ground deformation database.

1.4.1

Example 1.

In this first example, we illustrate how to extract the displacement data corresponding to
horizontal deformation greater than 300 cm.

1.

2
3.
4

Select Worksheet Displacements.
Using the Data menu, select Filter, and AutoFilter.
Pull the drop-down list at the header of column Hdisp, and select Custom... (Fig. 8).

In the Custom AutoFilter window (Fig. 9), click the drop-down menu and choose is
greater than, enter “3007, then click OK.

Select worksheet GISMap, and click the Display button to display the filtered data as
shown in Fig. 10.

»

1 21337902 4674317 1013 21337978 467462

3 21320116 4670203 241 21320205 48704.98
3 213093.94 4872097 969 2130953 48723.65
4 21302165 4879516 19.92 21302066 48796.13

IV Gefrations 7. Gistan { Summery £ B[4}

Figure 8. User-defined filter criteria using the column heading “Hdisp” in the Excel

worksheet Displacements.
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is greater than or equal ta
fis less than
is less than or equal to
Jibegins with
_|does not begin with
jends with :
. |does not end with

Figure 9. Custom AutoFilter dialog to input user-defined filter criteria “Hdisp >= 300cm”.

.

E3 Microsoft Excel - Daiaa;ummary i R G
G Fe gdr Vew lnset Foma Tools Data Yoindow

+

&
e

et

Por .

. o
et P

AP 5N O s { S sl Oiaarents { iyt { Retoanc | o
Figure 10.  User-defined query result for horizontal deformation greater than 300 cm in Excel

worksheet GISMap.

1.4.2 Example 2.

The second example illustrates how to extract boreholes and displacements data that are located
between the coordinates (46500, 210800) and (50000, 213500).

1. Select worksheet Boreholes.
2. Using the Data menu, select Filter, and AutoFilter.

3. Pull the drop-down list at the header of column Northing, and select Custom....
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4. 1In the Custom AutoFilter window (Fig. 11), click the drop-down list, choose is greater than,
enter “2108007, click A4nd, click the second drop-down list, choose is less than, enter
“2135007, and click OK.

Pull the drop-down list at the header of column Easting, and select Custom....
Repeat step 4 using “46500” and “50000”, respectively (See Fig. 12)
Select worksheet Displacements. ’

Repeat steps 2 to 6

© % N W

Select worksheet GISMap, and click the Display button in order to display results similar to
those of Fig. 13.

Figure 11. Custom AutoFilter dialog to input filter criteria for Northing coordinate between
210800 and 213500.

: Custm uloF' er

Figure 12. Custom AutoFilter dialog to input filter criteria for Easting coordinate between
46500 and 50000.
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Figure 13. User-defined query result of the coordinates between (46500, 210800) and
(50000, 213500) in Excel worksheet GISMap.

1.5 Data presentation and manipulation using GIS software

Spatial data (e.g., displacement vectors and borehole data) are best visualized using a GIS
environment. GIS files such as Basemap and DEM files can be visualized through GIS software
such as Surfer, ArcView and ArcGIS. GIS files in the liquefaction ground deformation database
are prepared using ArcGIS8.x, which is one of the most popular commercially available GIS
software (www.esri.com). DEM files are prepared according the standard format published by
USGS (www.usgs.gov).

1.5.1 Data presentation

Each case history contains two GIS project files with file extension name AEP or MXD, which
are included in the subdirectory GISFiles. ArcExplorer2.0 is required to use the AEP file to view
the content, and for the MXD file, ArcGIS8.x must be used.

ArcExplorer2.0 is a lightweight GIS data viewer, which has limited data visualization or
manipulation capabilities. As shown in Fig. 14, ArcExplorer2.0 can visualize AEP project files
containing displacements, boreholes, geographic and topographic data. The menu bar and tool
bars are useful to add themes to existing data sources, control theme characteristics, print the
maps, zoom in/out, pan and identify map features. Users also have the capability to query
geographic attribute data and perform basic statistical analysis.
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Explorer - Niigata AP
File Edit Yiew Theme Tools Help

¥ DISPLACEMENT
V4

# BOREHOLES
»

Vv WATER

7
/f“e

& STREETS
A
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‘ﬁ(

& BUILDINGS
n

M BOUNDARY

¢

A

Map copied to clipboard Sctwe Theme: BDUNDARY P

Figure 14. Example of ArcExplorer2.0 project file (data source from Niigata, Japan).

The liquefaction ground deformation database contains MXD project files, which require
ArcView8.x but provide much more flexibility to GIS users. Figure 15 shows an example of an
MXD project from the Niigata, Japan case history. In this project, Visual Basic functions were
implemented in the MXD to extend their usability. As shown in Fig. 15, a hyperlink function
displays borehole information on an HTML page. When the user moves the mouse over a given
area, the name of the boreholes in this area will be displayed. By clicking on a location,
boreholes will be listed in the “Hyperlinks™ dialog box, and users can select a particular borehole
to obtain more detailed information. For instance, Fig. 16 displays the available information on a
particular borehole, including the borehole ASCII file, original scanned image of borehole
profile, and LogPlot2001 data file.

Page 15



® Niigata - ArcMap - ArcView

T e e s oo

File Edit View Insert Selection Tools Window Help
D& - | |
BORCR-HERYE X

,x:

= water
= streets
s railways

= M boundary- E

Hyperlinks

Figure 15. Example of MXD project file with Hyperlink functionality (data source from
Niigata, Japan).
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A C:\peercdhtmBibtmilist, html - Microsoft Internet E.,. &)
File Edit View Favorites lpols Help

L Mk
hEpT

| This borehole has the following data available:

o Boring Log ASCII Data

Boring Log LogPlot Data

» Boring Log LogPlot Graph

o Boring Log Oringinal Scanned Image

| Reference about this borehole:
| Hamada Personal communicatoin 3/1/99 >

Figure 16. Available information list from selected borehole through the hyperlink.

1.5.2 Data manipulation

We will give two examples of visualization and utilization of the GIS files contained in the
liquefaction deformation database, using two common GIS systems, i.e., Surfer and ArcView8.x.

Example 1

The first example shows how to visualize a basemap file.
Surfer users

1. Select File -> Import menu.

2. From Import File dialog, navigate to the directory that contains the basemap file (Fig. 17),
select the file you want to visualize, and Click Open.

3. Customize the Import Option dialog or leave as default, and Click OK.
4. Repeat step 1 to 3 to Import all the basemaps required (See Fig. 18)
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3}}] rigata_road
3}}:] niigata_road_new
iﬁ] niigata_buiiding %3} niigata_water

%}ﬂ niigata_building_new 3_\‘3] niigata_water_new
533] niigata_railway

i}}] niigata_railway _new

Filepame:  Inigata_boundary

Fiesof lype: | All Recognized Types > Cancel |

Figure 17. Open file catalog for importing basemap file of Niigata boundary in Surfer.

o e ST e T it B 0 SO

¥ surfer - [Plot1]
ng File Edit view Draw Arrange

DEHES s2@

Jcomposit

8.75in, 4.06in 6.00inx3.86in

Figure 18. Imported Niigata basemap file in Surfer showing the Niigata city boundary.
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ArcGIS8.x users
1. Create a new Project from File menu.
2. Click Add data toolbar.

3. From Add data dialog, navigate to the directory that contains the basemap file (Fig. 19) and
select the file you want to visualize (Fig. 20). You can select multiple files pressing the Ctrl
key, and Click Add.

:’sdd Data
Al vater.shp
' dxxtawswzoa
‘?r niigata_boundary_new.shp
J nugata bwldmg_new shp
Name: iboundary. shp; ralways, shp; streets shp; water.shp; buildings _Add
Show of type:  [Datasets and Layers (") ~] Cancel |

Figure 19. Import file dialog to import basemap of Niigata city in ArcGIS8.x.
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rcMap - ArcView

% Untitled - A

f File Edt View Insert Selection Tools Window Help
IDERS 8% v &7
QIO Pe B ROBHE

x

= £ Layers A
i water !
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= M raibways

#“ M boundary
= buildings

¥ i

Display [ Source |

[ '54055.56 207927.78 Unknown | £

Figure 20. Imported Niigata basemap showing the water, street, railway, building and city
boundary in ArcGIS8.x. '

Example 2

The second example illustrates how to utilize the DEM files for deriving the slope information.
DEM files are handled differently by ArcView3.x and ArcGIS8.x. Step-by-step instructions are
given to import DEM files in Surfer, ArcView3.x and ArcGIS8.x. Due to a limitation of
ArcView3.x or ArcGIS8.x, users should be careful not to add any spaces within the file path of
DEM files.

Surfer users
1. Create a new Plot Document from File -> New.
2. Select Grid -> Calculus....

3. Navigate to the folder containing the DEM file in the Open Grid dialog (Fig. 21), select the
DEM file, and then Click Open.

4. From Grid Calculus Dialog, click the drop down list for Grid-to-Grid Operation to choose
Terrain Modeling, then click the drop down list for Output Grid File to specify the folder and
file name of the new grid, then click OK (Fig. 22).
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5. Select Map -> Contour Map -> New Contour Map, from Open Grid dialog navigate to the
file you just specified to select and open it.

6. Customize the Contour Map P}‘operties in the dialog or leave as default, then click OK (Fig.
23).

7. Slope derived from DEM is displayed as a contour map in the plot area (Fig. 24).

It is recommended to refer to the Surfer User’s Manual for more information and options on Grid
Calculus and Map Plotting.

Flename:  |563360

Files of lype: iAll Recognized Types

Grid Info >> |
B |

Figure 21. Open file dialog to navigate one of the DEM files in Niigata city using Surfer.

Grid Calculus

- Input Grid File

}F:\Ptelinmary Liquefaction Database\Niigata\GIS Files @

-~ Grid+to-Grid Operation
T enan Mo»ﬂéﬁng: Sy | QOptions...

- Qytput Grid File
§F:'\Preaiminaty Liquefaction Database\MigataA\GIS Files &5

Figure 22. Option of grid calculus to derive the slope information from DEM using Surfer.
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(Ion!our Map Pmpemes:_ e

Options | Levels §
- laput Gnd File
\ gF \Prefiminary Liquefaction Dakabase\Nngata\BiS Fles\DEM\outar €3 =

H

~Filled Contours -~ ~Smogthing -~~~ - Blanked Regions -~

r~ Fﬁ”ﬁé&&&m I SmoohContows | g Nove |
' R | Line: Invisible §

Faylt Line Properties:

—

m Cancel ; Apply

Figure 23. Contour map properties dialog to specify the contour map properties using Surfer.

.a gsr%in~rrs§;gk? *{}Td!\f-{éGDO‘h@U

110 : o1 o, 10 ], 12, 13, 14~

lMap Contours ) 12,67 in, 0.0%in 7.5%9iInx5.91in

Figure 24. One of the DEM files of Niigata city represented by Surfer.
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Figure 24. One of the DEM files of Niigata city represented by Surfer.
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ArcView3.x users

The utilization of DEM files in ArcView3.x requires the installation of either the Spatial Analyst

or the 3D Analyst extensions.

1. Create a new View from Project window.

2. Select File -> Import Data Source. ..

3. From Import Data Source dialog, select USGS DEM, and click OK (Fig. 25).

4. Navigate to select the DEM file from Import USGS DEM Files dialog, and click OK (Fig.

25).

5. Specify the Output grid file name and location, and click OK (Fig. 26). Ignore any error
message by clicking OK. o

Figure 27 gives an example of DEM files visualized in ArcView3.x.

%2 Import Data Source

Select import file ype:

JUSGS DEM

anN Generata File

R

T N e

%2 Import USGS DEM Files

File Mame:; Directories:
| 563860.dem tApreliminary iquefaction database\n
U bE3geldem =0 ]

[ 553961.dem (&> preliminary liquefaction dat: |

D 563970.dem & nigata

D) 563971.dem B> gis fles

Mmoo e
v -

List Files of Type: Drivas:
| DEM Files [*.dem] >~ |k ]

Figure 25.

Page 23

Import dialog to import one of the DEM file in Niigata city using ArcView3.x.




—~

Ditectories:
Fswork\gis\niigata\ 1984 _niigata\bas

-~ B £\ 'Y
= wark
= gs
= riigata
£ 1964_nigata
= basemap

Figure 26. Output grid dialog to specify the grid obtained from DEM data imported in
Figure25.

2 A YT I | —

Eile gdat View Theme Anaiym Suface  Graphics Window Help

I II%EI F) D &
Scale 1

xv
HEE
_ 13

Figure 27. A DEM files in Niigata city represented in ArcView3.x.
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Spatial Analyst or 3D Analyst extensions can be used to derive slope, after a DEM file has been
imported to ArcView3.x as grid file. Refer to the Online Help of ArcView3.x for advanced GIS

operations.

ArcGISS8.x users

ArcGIS8.x handles DEM files differently from ArcView3.x. The ArcToolBox, which is bundled
with ArcView8.x, must be launched to utilize DEM files.

1. Select Conversion tools -> Import to Raster -> DEM to Grid (Fig. 28).

2. Specify data source (path) of DEM file and provide a output grid file name in the DEM to
Grid dialog (Fig. 29).

When finished, the process generates a GRID file, which can be directly imported into
ArcView3.x or ArcView8.x. The same approach can be used to handle the grid file to get slope
or other spatial information.

i ArcToulbox ﬁrchew
Jools Help

t @ Import to Raster o

-4 About Import to Raster
- ASCH to Grid
Y
i DTED to Grid
+ - Floating Point Data to Grid
I P oDTSRaster ToGrd o
= @ Import to Shapefie B
: e &bout Import to Shapefile
A AGF to Shapefie
- Geodatabase to Shapefile
i P MIF to Shapefile )
-+ 7% Route Event Table to Feature Class Wizard |

Converts a Digital Elevation Model [DEM] in USGS format to a grid,

Figure 28. ArcToolbox DEM to grid utility in ArcView8.x.

,.?“ DEM to Gnd

USGS DEM: [FAWok\GIS\1371_SanFemandotdertS.a
---- Cotwexmn optiors :

: ﬁnd ype: & Float 1 Integer
Z-facton frmw

Quiput grid: [ w@}‘“

Batch ~ |

Figure 29. Import one of the DEM files in ArcView8.x.
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2. CONTENTS OF LIQUEFACTION GROUND DEFORMATION DATABASE

The liquefaction ground deformation database (Version 1.0) is made of two CDs. As listed in
Table 3, CD-1 contains the case histories of liquefaction-induced ground deformation from the
1964 Niigata, Japan earthquake; the 1971 San Fernando, California earthquake; the 1983
Noshiro, Japan earthquake; the 1989 Loma Prieta, California earthquake; and the 1994
Northridge California earthquake. CD-2 contains data from the 1995 Hyogoken-Nanbu, Japan

earthquake. _

Table 3. Case histories included in the liquefaction ground deformation database CDs
CD Case history
1 Niigata, Japan

Noshiro, Nihonkai-chubu, Japan
Van Norman Complex, California
Loma Prieta, California
2 Kobe, Hyogoken Nanbu, Japan

As detailed in the breakdown of SPT and CPT data in Table 4, the database contains a total of
5,204 boreholes, consisting of 4,975 SPT and 162 CPT soundings. Table 5 summarizes the actual
contents of the database in terms of displacement vectors. There are 16,191 vectors originating
from seven earthquakes and six regions in California and Japan. Table 6 summarizes the number
of displacement vectors. Most displacements are between 1 and 200 cm. Tables 7-10 summarize
all other information in the database, including aerial photos and original documents. The
contents of the GIS and DEM files in Tables 7-8 are displayed in Figs. 30-35.

Boreholes in each case history have been processed and plotted using LogPlot2001. The data
files for Logplot2001, which can be used to reproduce the graphic borehole profile, are included
in the CDs. Appendix A lists the soil lithology legend used in LogPlot2001 to illustrate the
different soil type in borehole test.

The coordinate of spatial data such displacement and borehole has been identified in the
DataSummary.xls for each case history. The data from Japan uses the unique Japanese
coordinate system, which is documented in the Appendix B.

Table 4. Summary of SPT and CPT soundings in the database.

Location SPT CPT
Niigata, Japan 645 -
Noshiro, Nihonkai-chubu, Japan 71 -
Kobe, Hyogoken Nanbu, Japan 4002 -
Van Norman Complex, USA 257 153
Loma Prieta, USA - 9
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Table S. Summary of displacement vector data in the database.
Earthquake Year Area Name Number
Niigata 1964 Niigata, Japan 2498
San Fernando 1971 Jensen Filtration Plant 864
Nihonkai-Chubu,Japan 1983 Noshiro,Japan 2954
Loma Prieta 1989 San Francisco, USA -
Northridge 1994  Van Norman Complex 1011
Hyogoken Nanbu Earthquake 1995 Kobe, Japan 8894
Table 6. Summary of aerial photos in the database.
Location Number of aerial photos
Kobe 59
Loma Prieta 1 (Marina district in California).
Niigata 20
Van Norman Complex 67
Noshiro 4
Table 7. Summary of basemaps in the database.
Location Description
Includes several ESRI shapefiles* covering Kobe City, Japan. The shape files are converted from
Kobe "Digital Map 50m Grid (elevation) Nippon-IIL," published by the Japan Geographical Survey

Loma Prieta

Niigata

Van Norman
Complex

Noshiro

Institute. Also contains railway, roads, water, building, and city boundary shape files of Kobe City.
One image file covering the Marina district in California.

Includes several ESRI shape files covering Niigata City, Japan. The shape files are converted from
"Digital Map 50m Grid (elevation) Nippon-1I1," published by Japan Geographical Survey Institute.
Also contains railway, roads, water, building, and city boundary shapefiles of Niigata City.

Image files scanned from original paper maps of the Van Norman Complex in California.
Includes several ESRI shapefiles covering Noshiro City, Japan. The shapefiles are converted from

"Digital Map 50m Grid (elevation) Nippon-IIL" published by Japan Geographical Survey Institute.
Also contains railway, roads, water, building, and city boundary shapefiles of Noshiro City.
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Table 8. Summary of DEMs in the database.
Location Description
8 DEM files covering Kobe City, Japan. The DEM files are converted to USGS DEM format from
Kobe "Digital Map 50m Grid (elevation) Nippon-III," published by the Japan Geographical Survey

Loma Prieta

Niigata

Northridge

Noshiro

San Fernando

Institute.

2 USGS DEM zip files downloaded from http://edc.usgs.gov/geodata. The DEM files cover the east
and west region of San Francisco Bay, California.

4 DEM files covering Niigata City, Japan. The DEM files are converted to USGS DEM format from
"Digital Map 50m Grid (elevation) Nippon-IIL," published by the Japan Geographical Survey
Institute.

2 USGS DEM zip files downloaded from http://edc.usgs.gov/geodata.
The DEM files cover the San Fernando Valley and Oat Mountain, California.

4 DEM files covering Noshiro City, Japan. The DEM files are converted to USGS DEM format from
"Digital Map 50m Grid (elevation) Nippon-III," published by the Japan Geographical Survey
Institute.

1 text file, which provides elevation points in San Fernando valley. This file can be used to generate a
DEM using GIS software such ESRI ArcView.
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Figure 30.
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Table 9. Summary of original displacement vectors data files

Earthquake Data Description
Original data supplied by Prof. Hamada. This data has been imported to
1964 Niigata vector.xls Excel file format. Displacement vectors are represented by pre and post
earthquake coordinates. '
vncnol.dat
znnz?lg‘;"g:: Original displacement vectors are digitized from displacement maps
1971 SanFernando vneno 4' dat supplied by LADWP. The pre and post earthquake coordinates, horizontal
’ displacement sand vertical settlements are provided.
vncnoS5.dat
vncnob6.dat
noshiro_pre.txt Original data supplied by Prof. Hamada. Displacement vectors are

1983 Nihonkaichubu

1994 Northridge

1995 Kobe

noshiro_post.txt

Vet NR1994.dat

hanshin_pre.txt
hanshin_post.txt

represented by pre and post earthquake coordinates and settlements.

Displacement vectors are represented by pre and post earthquake
coordinates and settlements.

Original data extracted from KOBE JIBANKUN database from Japan.
Displacement vectors are represented by pre and post earthquake
coordinate and settlement.

Table 10.  Summary of scanned documents on boreholes.

Location

Description

Niigata
Noshiro

Van Norman Complex
Kobe

Loma Prieta

Original borehole data are scanned and stored as image files.

Original borehole data are stored in the database. No image files are available.

Original SPT profiles are as image files. Original CPT data files are stored as collected.

SPT information is stored in the database. Data was extracted and translated from
KOBE JIBANKUN database.

CPT profiles are scanned as image files.
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APPENDIX A: BOREHOLE LEGENDS

Alt. of Sand and Clay

ESilty Sand

OO O ;
660 Coarse sand w ith gravel

— —[Sand with Pebbles

Y/ \Alt of Humus and Sand

and with Shells

Sand with loam

ity sandstone and clayey
andstone

arse Sand with Rounded
Stones~Clay with Rounded

N Sandstone and gravel

Sandstone and cobbies

Sandstone and silty siltstone

iGravel w ith Silt

ZP > Gravel with sand

: 'Sandy siltstone

ravel and cobbles

Clayey siltstone and gravel

Mud

Sitty claystone

Alt of Sitt and Clay w ith
andy Gravel

ity claystone and gravel
land sand

Sitt w ith gravel

|Silty claystone and sandy
. < [claystone and gravel

nglomerate

<)

. AConglomerate layered with
- Jsandstone layered w ith clay

sphait

Bedrock(Granite)

oam

Coals

Page 36



APPENDIX B: COORDINATE SYSTEMS IN LIQUEFACTION-INDUCED GROUND
DEFORMATION DATABASE

There are several coordinate systems available for characterizing the position of a point on the
earth surface. Geographic coordinate system is one set of coordinate system used around the
world. Coordinate position on the spherical surface is uniquely defined by means of two
vectorial angles: latitude and longitude. This is one unique coordinate system extensively used
for all kinds of purpose including global positioning system (GPS) and map projection. There are
also other set of coordinate systems called plane cartesian coordinates which are used in
surveying and mapping. These coordinates systems use two orthogonal axes: the y-axis in
ordinate, and the x-axis in abscissa. Sometimes the abscissa is called Easting and the ordinate
Northing. Different regions of the world use different coordinate systems to maintain accurate
maps. The liquefaction-induced ground deformation database utilizes three different types of

coordinate systems:
1. Globe geographic coordinate system, using longitude and latitude.
2. Japan cartesian coordinate.
3. US cartesian coordinate (Universal Transverse Mercator system).

The Japan Cartesian coordinate is designed by the Japan Tertian Geographic Institution. It
divides Japan into 19 zones, each of which covers 600 km (N-S) by 320 km (E-W) area. Each
zone has its own coordinate origin and supplies one globe geographic coordinate system. Every
zone is also divided into several 30 km (N-S) x 40 km (E-W) regions.

The Universal Transverse Mercator (UTM) system was devised in the late 1940s by the US
Army, and has been widely used around the world since. It intends to provide world coverage
between the latitudes 84°N and 80°S. The world has been divided into 60 zones. Each zone is 6°
longitude in width and extends from 80°S to 80°N. The origin of each zone is the point on the
equator where it is intersected by the central meridian of the zone. The Eastings of the origin of
each zone are assigned the value of 500,000 m. For the northern hemisphere, the Northing
~ coordinate of equator is zero, but for the southern hemisphere, the equator is assigned a Northing
value of 1,000,000 m. The transformation of coordinates between Japan Cartesian coordinates,
UTM coordinates and geographic coordinates are given in this Appendix.

Transformation from UDL to UTM and Japanese cartesian coordinate systems

Provided that the drawings and photographs are free of distortions and warping, these local
cartesian systems can be related to the more general cartesian systems (e.g., UTM) by basic
transformation of coordinates including translation of axes origin, change in scale, and rotation
of axes. As shown in Fig. Bl, the final global horizontal position (X;¥) of point M is related to
the local user-defined horizontal position (, y) through:

X\ (X, cos@ sinf | x )
Y) |7, +f —sind cosé |\ y M
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where f is the scale ratio between local and global coordinates, & is the rotation of axis-
coordinates (generally set to zero), and (Xp , Yy) is the global coordinates of point O.

Within a specific global coordinate system, there are many ways of defining ground elevation,
related to the choice of datum, e.g., mean sea level. Therefore, the following transformation may

be necessary to have elevations expressed with the same datum:
Z=2-2p (2)

where Z, is the difference between the local and global datum. In other words, the coordinates of
a point are specified by using three variables: X, y, z, and a transformation type / to a global
coordinate system, which is characterized by 6 variables: 1, 6, f, Xy, Yo, and Zy. All the points
digitized from the same maps or drawings have the same transformation type /. The selection of
user-defined coordinates and transformation type is general enough to adapt to all situations.
When the global coordinates are selected as user-defined coordinates, then the transformation

type is trivial, i.e., =0, f=1, Xp =Yy =2 = 0.

A
Y
y
M
O
Yol — — — —
o)
| /\/\/
|
X
]
|
|
|
>
Xo X

Figure B1. Transformation of user-defined coordinates into a global coordinate system.

Coordinate transformation from geographic to Japanese systems

The following section is an excerpt from Japan Association for Surveying, 1999, Regulations for
surveying of control points, http://vldb.gsi-me.go.jp/sokuchi/surveycale/xy2bl/xy2bl.html (in

Japanese).
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where,
@ : Latitude of point of interest
4, : Longitude of reference point

A : Longitude of point of interest

y : meridian aberration angle of point of interest

sign of y is negative when the point of interest is located in the east of Cartesian coordinate, and
positive in the west.

m : scale factor of point of interest

Page 39



m, =0.9999
nt =e’cos’ @,
y .y coordinate of point of interest

a : major axis length of ellipse (bessel 6377397.155m)
f : flattening (bessel 1/299.152813)

c P T

M =—=——o  N-= =N T

(1+72) i) 1771

Latitude of intersection between standard meridian and a perpendicular line from the point of
interest '

A0+ 4,sin20 + 4, sin40 + 4,6 cos 26 + 4, sin 66 + 4,0 cos46
@, =| + 4,07 sin 26 + 4, sin 20 cos 40 + A, sin 86 + A4,,6 cos 66 + A,,0sin20sin 46 |p
+ 4,07 sin40 + 4,,0° cos 26 + A,, sin 60 cos 20

where,
o=
a
M=S,+ x X coordinateof point of interest
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Arc length of meridian from the equator to the origin of Cartesian Coordinate

S, : Arc length of median from the equator to the origin of Cartesian Coordinate ¢,
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